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Legal Information
The information provided in this document contains general descriptions, technical
characteristics and/or recommendations related to products/solutions.

This document is not intended as a substitute for a detailed study or operational and
site-specific development or schematic plan. It is not to be used for determining
suitability or reliability of the products/solutions for specific user applications. It is the
duty of any such user to perform or have any professional expert of its choice
(integrator, specifier or the like) perform the appropriate and comprehensive risk
analysis, evaluation and testing of the products/solutions with respect to the relevant
specific application or use thereof.

The Schneider Electric brand and any trademarks of Schneider Electric SE and its
subsidiaries referred to in this document are the property of Schneider Electric SE or
its subsidiaries. All other brands may be trademarks of their respective owner.

This document and its content are protected under applicable copyright laws and
provided for informative use only. No part of this document may be reproduced or
transmitted in any form or by any means (electronic, mechanical, photocopying,
recording, or otherwise), for any purpose, without the prior written permission of
Schneider Electric.

Schneider Electric does not grant any right or license for commercial use of the
document or its content, except for a non-exclusive and personal license to consult it
on an "as is" basis.

Schneider Electric reserves the right to make changes or updates with respect to or in
the content of this document or the format thereof, at any time without notice.

To the extent permitted by applicable law, no responsibility or liability is
assumed by Schneider Electric and its subsidiaries for any errors or omissions
in the informational content of this document, as well as any non-intended use
or misuse of the content thereof.
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Safety Information
Important Information

Read these instructions carefully, and look at the equipment to become familiar
with the device before trying to install, operate, service, or maintain it. The
following special messages may appear throughout this documentation or on the
equipment to warn of potential hazards or to call attention to information that
clarifies or simplifies a procedure.

Please Note
Electrical equipment should be installed, operated, serviced, and maintained only
by qualified personnel. No responsibility is assumed by Schneider Electric for any
consequences arising out of the use of this material.

A qualified person is one who has skills and knowledge related to the construction
and operation of electrical equipment and its installation, and has received safety
training to recognize and avoid the hazards involved.

The addition of this symbol to a “Danger” or “Warning” safety label indicates that an 
electrical hazard exists which will result in personal injury if the instructions are not 
followed.

This is the safety alert symbol. It is used to alert you to potential personal injury 
hazards. Obey all safety messages that follow this symbol to avoid possible injury or 
death.

DANGER indicates a hazardous situation which, if not avoided, will result in death or serious 
injury.

! DANGER

WARNING indicates a hazardous situation which, if not avoided, could result in death or 
serious injury.

WARNING!

CAUTION indicates a hazardous situation which, if not avoided, could result in minor or 
moderate injury.

CAUTION!

NOTICE is used to address practices not related to physical injury.

NOTICE
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About the Book
Document Scope

This document describes the graphical user interface of the EcoStruxure Machine
Expert Twin software and the functions it provides. For further information, refer to
the separate documents provided in the EcoStruxure Machine Expert Twin online
help.

Validity Note
This document has been updated for the release of EcoStruxure Machine Expert
Twin V2.0.

Available Languages of this Document
This document is available in these languages:

• English (EIO0000005022)

Related Documents
Document title Reference

Cybersecurity Best Practices CS-Best-Practices-2019-340

Cybersecurity Guidelines for EcoStruxure
Machine Expert, Modicon and PacDrive
Controllers and Associated Equipment

EIO0000004242

EcoStruxure Machine Expert Twin How to
Create Device Catalogs - User Guide

EIO0000005034 (ENG)

To find documents online, visit the Schneider Electric download center
(www.se.com/ww/en/download/).
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Product Related Information

WARNING
LOSS OF CONTROL
• Perform a Failure Mode and Effects Analysis (FMEA), or equivalent risk

analysis, of your application, and apply preventive and detective controls
before implementation.

• Provide a fallback state for undesired control events or sequences.
• Provide separate or redundant control paths wherever required.
• Supply appropriate parameters, particularly for limits.
• Review the implications of transmission delays and take actions to mitigate

them.
• Review the implications of communication link interruptions and take actions

to mitigate them.
• Provide independent paths for control functions (for example, emergency

stop, over-limit conditions, and error conditions) according to your risk
assessment, and applicable codes and regulations.

• Apply local accident prevention and safety regulations and guidelines.1

• Test each implementation of a system for proper operation before placing it
into service.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

1 For additional information, refer to NEMA ICS 1.1 (latest edition), Safety
Guidelines for the Application, Installation, and Maintenance of Solid State Control
and to NEMA ICS 7.1 (latest edition), Safety Standards for Construction and
Guide for Selection, Installation and Operation of Adjustable-Speed Drive
Systems or their equivalent governing your particular location.

WARNING
UNINTENDED EQUIPMENT OPERATION
• Only use software approved by Schneider Electric for use with this

equipment.
• Update your application program every time you change the physical

hardware configuration.
Failure to follow these instructions can result in death, serious injury, or
equipment damage.
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For reasons of Internet security, for those devices that have a native Ethernet
connection, TCP/IP forwarding is disabled by default. Therefore, you must
manually enable TCP/IP forwarding. However, doing so may expose your network
to possible cyberattacks if you do not take additional measures to protect your
enterprise. In addition, you may be subject to laws and regulations concerning
cybersecurity.

WARNING
UNAUTHENTICATED ACCESS AND SUBSEQUENT NETWORK INTRUSION
• Observe and respect any and all pertinent national, regional and local

cybersecurity and/or personal data laws and regulations when enabling
TCP/IP forwarding on an industrial network.

• Isolate your industrial network from other networks inside your company.
• Protect any network against unintended access by using firewalls, VPN, or

other, proven security measures.
Failure to follow these instructions can result in death, serious injury, or
equipment damage.

Consult the Schneider Electric Cybersecurity Best Practices for additional
information.

EcoStruxure Machine Expert Twin is a simulation and emulation software suite to
create digital models of real machines to start the virtual design, virtual pre-
commissioning, and to support co-development before building the machine –
thus enabling parallel engineering of mechanical, electrical and controls work
assignments.

The simulation, emulation and machine visualization functions of EcoStruxure
Machine Expert Twin are intended to support you in developing your application
and its configuration by simulating the behavior of the various machine or process
components. These functions are not intended to substitute for, but to complement
the processes of risk assessment, risk evaluation, validation, and commissioning
as well as any ancillary processes, tasks, and obligations according to the
applicable regulations and standards such as ISO/EN 13849 and IEC 62061. The
product, though powerful, does not, nor can it, simulate every aspect of the
application and its environment.

WARNING
INSUFFICIENT TEST COVERAGE
• Do not use EcoStruxure Machine Expert Twin as the sole means for risk

assessment, risk evaluation, validation, and commissioning as well as any
ancillary processes, tasks, and obligations according to the applicable
regulations and standards such as, but not limited to, ISO/EN 13849 and IEC
62061.

• Verify and validate your results on the intended equipment before placing
your machine or process into service.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.
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Based on the system configuration and operation, a hazard and risk analysis must
be conducted for the system (for example, according to ISO 12100 or ISO 13849-
1) independent of the work with EcoStruxure Machine Expert Twin. The results of
this analysis must be considered when designing the machine, and subsequently
applying safety-related equipment and safety-related functions. The results of
your analysis may deviate from any digital models of physical machines that you
may create. For example, additional safety components may be required. In
principle, the results from the hazard and risk analysis have priority.

WARNING
NON-CONFORMANCE TO SAFETY FUNCTION REQUIREMENTS
• Specify the requirements and/or measures to be implemented in the risk

analysis you perform.
• Verify that your safety-related application complies to applicable safety

regulations and standards.
• Make certain that appropriate procedures and measures (according to

applicable sector standards) have been established to help avoid hazardous
situations when operating the machine.

• Use appropriate safety interlocks where personnel and/or equipment
hazards exist.

• Validate the overall safety-related function and thoroughly test the
application.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

Catalogs contain important data, parameters and operational aspects of the
devices defined within. This information is subject to change over time for a variety
of reasons. Therefore, it is necessary to maintain the relationship between the
models you create and the catalogs you have used to do so. Version mismatches
of catalogs may cause your models to operate in ways that are incongruent with
the equipment they represent and may lead to errors in design and operation.

WARNING
UNINTENDED EQUIPMENT OPERATION
• Impose a system of file name conventions that readily indicate the version of

the catalogs you use and models you create.
• Create documentation that records catalog and model versions, as well as

firmware versions of the equipment used in your models.
Failure to follow these instructions can result in death, serious injury, or
equipment damage.

In addition, changes to your underlying application (logic, data address, functions,
I/O configurations, device types and configuration, etc.) can have serious impact
on the models you have created.

WARNING
UNINTENDED EQUIPMENT OPERATION
• Update your models every time you modify your application or change the

physical hardware configuration.
• Verify that objects you have created in your models are coherent with the

modifications and/or changes you have made to your application and that
they are associated with the correct variables.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.
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It is also important to connect to the correct automation logic/motion controller in a
networked, multi-controller environment.

WARNING
UNINTENDED EQUIPMENT OPERATION

Verify that you have connected to the intended automation controller.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

It is important to manage the amount of data that is transmitted between your
automation logic/motion controller and EcoStruxure Machine Expert Twin. Large
amounts of data, or data that is not contiguous in the controller memory may
impact performance of EcoStruxure Machine Expert Twin, the controller or both.

Information on Non-Inclusive or Insensitive Terminology
As a responsible, inclusive company, Schneider Electric is constantly updating its
communications and products that contain non-inclusive or insensitive
terminology. However, despite these efforts, our content may still contain terms
that are deemed inappropriate by some customers.

Terminology Derived from Standards
The technical terms, terminology, symbols and the corresponding descriptions in
the information contained herein, or that appear in or on the products themselves,
are generally derived from the terms or definitions of international standards.

In the area of functional safety systems, drives and general automation, this may
include, but is not limited to, terms such as safety, safety function, safe state, fault,
fault reset, malfunction, failure, error, error message, dangerous, etc.

Among others, these standards include:

Standard Description

IEC 61131-2:2007 Programmable controllers, part 2: Equipment requirements and tests.

ISO 13849-1:2023 Safety of machinery: Safety related parts of control systems.

General principles for design.

EN 61496-1:2013 Safety of machinery: Electro-sensitive protective equipment.

Part 1: General requirements and tests.

ISO 12100:2010 Safety of machinery - General principles for design - Risk assessment
and risk reduction

EN 60204-1:2006 Safety of machinery - Electrical equipment of machines - Part 1: General
requirements

ISO 14119:2013 Safety of machinery - Interlocking devices associated with guards -
Principles for design and selection

ISO 13850:2015 Safety of machinery - Emergency stop - Principles for design

IEC 62061:2021 Safety of machinery - Functional safety of safety-related electrical,
electronic, and electronic programmable control systems

IEC 61508-1:2010 Functional safety of electrical/electronic/programmable electronic safety-
related systems: General requirements.

IEC 61508-2:2010 Functional safety of electrical/electronic/programmable electronic safety-
related systems: Requirements for electrical/electronic/programmable
electronic safety-related systems.

IEC 61508-3:2010 Functional safety of electrical/electronic/programmable electronic safety-
related systems: Software requirements.

10 EIO0000005022.01
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Standard Description

IEC 61784-3:2021 Industrial communication networks - Profiles - Part 3: Functional safety
fieldbuses - General rules and profile definitions.

2006/42/EC Machinery Directive

2014/30/EU Electromagnetic Compatibility Directive

2014/35/EU Low Voltage Directive

In addition, terms used in the present document may tangentially be used as they
are derived from other standards such as:

Standard Description

IEC 60034 series Rotating electrical machines

IEC 61800 series Adjustable speed electrical power drive systems

IEC 61158 series Digital data communications for measurement and control – Fieldbus for
use in industrial control systems

Finally, the term zone of operation may be used in conjunction with the description
of specific hazards, and is defined as it is for a hazard zone or danger zone in the
Machinery Directive (2006/42/EC) and ISO 12100:2010.

NOTE: The aforementioned standards may or may not apply to the specific
products cited in the present documentation. For more information concerning
the individual standards applicable to the products described herein, see the
characteristics tables for those product references.

EIO0000005022.01 11
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General Introduction to the EcoStruxure Machine
Expert Twin

What’s in This Chapter

Overview of the EcoStruxure Machine Expert Twin Product Portfolio .................14

Overview of the EcoStruxure Machine Expert Twin
Product Portfolio

Introduction
The EcoStruxure Machine Expert Twin product portfolio consists of the following
segments:

• EcoStruxure Machine Expert Visu
This viewer integrated in EcoStruxure Machine Expert provides a subset of
the functions of EcoStruxure Machine Expert Twin. It allows you to test the
application code and to display a 3-D emulation of the objects, for example,
one multi carrier track or one robot, from within EcoStruxure Machine Expert.
You can reuse the scenes of single machines to virtual commissioning of the
entire machine production line inside EcoStruxure Machine Expert Twin
Builder.

• EcoStruxure Machine Expert Twin
The standalone EcoStruxure Machine Expert Twin application is installed
using the Schneider Electric Software Installer and requires a separate
license. It includes different components:
◦ EcoStruxure Machine Expert Twin Builder

The Builder License allows the emulation of a machine when the controller
is connected. It includes predefined catalogs that provide objects you can
use as assemblies in your scene.

◦ EcoStruxure Machine Expert Twin Designer
The EcoStruxure Machine Expert Twin Designer allows the emulation of
machines without a controller being connected (discrete events
simulation).

◦ EcoStruxure Machine Expert Twin Developer
The Developer License allows you to create your own emulation
components and catalogs as well as plugins, tools, interfaces you can
adapt to your workflow, processes and data sources.

14 EIO0000005022.01
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Overview of the User Interface
What’s in This Chapter

Elements of the Screen..................................................................................16
Information About the Coordinate System .......................................................17

Elements of the Screen

Default Screen
After initial startup, the default screen is displayed. It consists of the following
elements:

1 Toolbar, page 20

2 Menu bar, page 21 with button bar representing the commands corresponding to
the selected menu

3 Model view, page 45, Script view, page 48

4 Connections view, page 39 / Catalogs view, page 42

5 Control Panel view, page 43 providing tabs for different controls

6 Logs view, page 49, Loads view, page 51, Inputs, Outputs views, page 52,
Alarms view, page 53, Joint Editor view, page 54, Change History view, page
57

7 Statistics view, page 61 / Solution Explorer view, page 58

8 Properties view, page 62

7

8

Copy 
(Clipboard)

Undo Redo Cut Copy Paste Select All

Select

Connections

ID Name Status Protocol

Clipboard

Catalogs Connections

Control Panel

Controls (1) Controls (2)

Machine Expert Twin Builder

File View Settings Tools ModelEdit

Model Script

Paused Scan: 0 µs 00:00:00 00:00:00 1

Logs

Tail

[14:17:29.817] Delta Robots (1.2.7.0) catalog loaded

[14:17:29.926] Field Equipment (1.2.1.0) catalog loaded

[14:17:29.945] multi carrier (1.2.7.0) catalog loaded

Logs Inputs Outputs AlarmsLoads Joint Editor

Statistics

Total Count

Loads 0

Max.

0 0

Solution Explorer Statistics

Search

Properties

2
1

4

5

3

6

Auto-GenerationKinematization

Change History
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Information About the Coordinate System

General Definition for 3-D Software Applications
In 3-D software applications, a coordinate system is a mathematical system that is
used to represent the position and orientation of objects in a three-dimensional
space. It consists of three perpendicular axes (X axis, Y axis, and Z axis) that
intersect at a point called the origin.

Color Definition of Coordinates and Denomination of Rotation
The axes of the coordinate system in EcoStruxure Machine Expert Twin are color-
coded as follows:

• X: red
• Y: green
• Z: blue

Denomination of rotational movement around the different axes is as follows:
• Rotation around the X axis: RotX
• Rotation around the Y axis: RotY
• Rotation around the Z axis: RotZ

Intrinsic Rotations Convention
With reference to the global EcoStruxure Machine Expert Twin coordinate system,
rotations of local assembly coordinate systems of individual body assemblies are
performed according to the intrinsic convention with the default orientation
convention ZYX. In an intrinsic system, each of the elemental rotations is
performed on the coordinate system as rotated by the previous operation(s).

As an example, suppose the three angles specify rotations around the Z, Y, and X
axes are in that order:

• The first elemental rotation is around the Z axis.
• For the intrinsic convention the second elemental rotation is performed

around the Y axis in the new position resulting from the first rotation.
• The final rotation around the X axis is performed around the X axis as rotated

by the two previous operations in the intrinsic system.
The relationship between the three axes is fundamental in EcoStruxure Machine
Expert Twin and is used to determine the orientation and position of body
assemblies in a scene.

EIO0000005022.01 17
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Order of Rotational Movements
When values for rotational movements of the different types are provided at the
same time, for example, if an object is added by using the orientation values from
the OPC UA structures, rotational movements are executed in the following order:

1. Around the Z axis:

The vector z is pointing in your direction.

The intermediate vectors u1 and v1 are implicit.
2. Around the Y axis:

The vector v1 is pointing in your direction.

The intermediate vectors u1, v1, and w2 are implicit.
3. Around the X axis:

The vector x’ is pointing in your direction.

The intermediate vectors u1, v1, and w2 are implicit.

18 EIO0000005022.01
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Toolbar

Default Elements of the Toolbar
By default, the toolbar provides the following elements:

Element Shortcut Description

New Ctrl + N Create a new project.

Open Ctrl + O Open an existing project.
Your file contains script code created or modified by you or by
someone else. The execution of the script code may
compromise the security of your IT system.

WARNING
INFORMATION SYSTEM VULNERABILITY
• Ensure the integrity of the script code

contained in the file by ascertaining the
originator and intent of the script before
opening the file.

• Do not open the file if you can not
determine the originator and intent of the
script, including confirming any
modifications that may have been made.

• Verify and confirm that you want to execute
this code when using the model contained
in the file.

Failure to follow these instructions can
result in death, serious injury, or equipment
damage.

When attempting to open a file with a model containing script
code, you are asked to acknowledge this advisory and accept
responsibility for the execution of the code of the embedded
script.

Save Ctrl + S Save the open project with file extension .Experior.

Lock Ctrl + L Lock the open project: the scene is locked against edits, no
modifications are possible, values are greyed and buttons are
unavailable.

To lock specific elements of a scene, such as an assembly or
a section, refer to the Solution Explorer view, page 58 or the
Properties, page 62 of the specific element.

Play - Play the scene. The Play button enables the physical
simulation.

Show Quick
Access Toolbar
Below the Ribbon
/ Show Quick
Access Toolbar
Above the Ribbon

- Click Show Quick Access Toolbar Below the Ribbon to
shift the toolbar below the menu bar.

Click Show Quick Access Toolbar Above the Ribbon to
shift the toolbar above the menu bar.

Right-click this toggle buttons to access the following
commands:

• Minimize the Ribbon:
Execute this command from the contextual menu to
display or hide the button bar corresponding to the
menu selected in the menu bar: The buttons are hidden
until you execute the Minimize the Ribbon command
again or until you select another menu in the menu bar.

• Customize the Ribbon
Opens the Ribbon customization window and allows
you to customize the buttons and commands displayed
in the menus.

20 EIO0000005022.01
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Menu Bar
What’s in This Chapter

File Menu .....................................................................................................21
Edit Menu.....................................................................................................23
View Menu ...................................................................................................24
Settings Menu..............................................................................................26
Tools Menu ..................................................................................................28
Model Menu .................................................................................................29
Kinematization Menu ...................................................................................31
Auto-Generation Menu.................................................................................38

The menu bar is by default extended by a button bar that provides the commands
of each menu in the form of buttons. This chapter describes the default
commands, provided by each menu.

File Menu

Commands of the File Menu
The File menu is grouped in different sections:

EIO0000005022.01 21
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File Section
Command Shortcut Description

New Ctrl + N Creates a new project.
Your file contains script code created or modified by you or by
someone else. The execution of the script code may
compromise the security of your IT system.

WARNING
INFORMATION SYSTEM VULNERABILITY
• Ensure the integrity of the script code

contained in the file by ascertaining the
originator and intent of the script before
opening the file.

• Do not open the file if you can not determine
the originator and intent of the script,
including confirming any modifications that
may have been made.

• Verify and confirm that you want to execute
this code when using the model contained in
the file.

Failure to follow these instructions can
result in death, serious injury, or equipment
damage.

When attempting to open a file with a model containing script
code, you are asked to acknowledge this advisory and accept
responsibility for the execution of the code of the embedded
script.

Open Ctrl + O Opens an existing project.

As a project file contains executable script code, carefully verify
whether this project file originates from a trusted source
because opening a tampered project file can compromise the
security of your IT system before you click Exit or activate the
check box and click Continue.

Save Ctrl + S Saves the open project with file extension .Experior.

Save As Ctrl + Shift + S Saves the open project with a file name and in the directory of
your choice.

Import Section

Command Shortcut Description

Merge - Allows you to merge two parts of a machine that have been
designed independently as scenes and saved as EcoStruxure
Machine Expert Twin projects in .Experior file format. For a
step-by-step description, refer to Merging Projects, page 23.

XML - Imports an XML file that has an EcoStruxure Machine Expert
Twin-compatible format. Files of type .Experior or .zip are
supported.

Also refer to Importing a CAD File, page 34 in the Kinematization Menu, page 31.

22 EIO0000005022.01
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Merging Projects
To merge two parts of a machine that have been designed as independent .
Experior projects, proceed as follows:

Step Action

1 Create an EcoStruxure Machine Expert Twin project in .Experior file format for a part of
your machine, for example, a conveyor belt.

2 Save and close this project file.

3 Create a second EcoStruxure Machine Expert Twin project in .Experior file format and
design another part of your machine, for example, a robot.

4 Save the second file and click File > Merge to display a file open dialog box.

5 Browse to the .Experior file you created for the conveyor belt and click Open.

Result: The Merge/Overwrite Objects dialog box opens.

6 Verify the objects that are selected in the dialog box for Insert and Overwrite and adapt
the selections to your needs.

7 Select the option Reuse sections (if they exist in the current model) to add the
assemblies of the conveyor belt project to be merged to an existing section of the open
robot project if the section name is identical and click OK.

Result: In the Solution Explorer view, the conveyor belt is added to the respective
Section node.

For a visual illustration of this merging process, refer to the merge
functionality video sequence.

Export Section

Command Shortcut Description

Collada - Exports the assemblies in the scene as a Collada
(COLLAborative Design Activity) file with the file extension .dae
to allow for exchange with other applications.

For importing a Collada file, refer to Importing a CAD File, page 34 in the
Kinematization Menu, page 31.

Help Section

Command Shortcut Description

About - Opens a dialog box providing information about the
components (such as catalogs or plugins) that are loaded.
Furthermore, it provides links to the EcoStruxure Machine
Expert Twin Release Notes and to the Schneider Electric
License Manager allowing you to verify the license status.

Help - Opens the EcoStruxure Machine Expert Twin Online Help.

Edit Menu

Commands of the Edit Menu
The Edit menu is grouped in different sections:
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Clipboard Section

Command Shortcut Description

Undo Ctrl + Z Undoes the action which was most recently executed. Repeated
use undoes the actions back to when the project was opened.

Redo Ctrl + Y Restores an action in the open project which has been undone
before.

Cut Ctrl + X Cuts selected parts of the Model view and transfers the selection
to the clipboard.

Copy Ctrl + C Copies selected parts of the Model view and allows to paste
these parts within the same EcoStruxure Machine Expert Twin
instance.

Copy
(Clipboard)

- Copies the selection to the clipboard and allows for pasting
between separate EcoStruxure Machine Expert Twin instances.

Paste Ctrl + V Pastes the content from the clipboard at the cursor position.

Select Section
Command Shortcut Description

Select All Ctrl + A Selects all components in the Model view.

View Menu

Commands of the View Menu
The View menu is grouped in different sections:

Windows Section
Command Shortcut Description

Windows - Select the views from the list that should be displayed in the
EcoStruxure Machine Expert Twin screen. The selection is saved
in the general settings. When you open EcoStruxure Machine
Expert Twin next time, the selected views will be displayed.

Reset - Resets the views within the EcoStruxure Machine Expert Twin
screen to the default state in terms of location and state as
indicated in the section Default Screen, page 16.

Colors Section
Command Shortcut Description

Background - Select the color used for the background in the Model view.

Assembly - Select the color used for the components you have placed in the
Model view. You can select different colors for:

• Assembly: Color of the assemblies.
• Selection: Color of selected components.
• Locked: Color of locked components.
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Scene Section
Command Shortcut Description

Rendering - Switch the rendering function On or Off by sliding the control to
the right or to the left.

When rendering is deactivated, no modifications are displayed in
the scene.

Lock /
Unlock

- Lock either the entire scene or the selected assemblies to help
avoid inadvertent actions or unintended modifications.

Sections - Opens a list of sections you created and displays the available
options:

• Show/hide Section
• Lock/unlock Section
• Enable/disable Section

Floor Section
Command Shortcut Description

AutoCad - Opens a Select AutoCAD Files dialog box that allows you to
import .dwg or .dxf files.

Debug Section

Command Shortcut Description

Level - This command allows you to select the following debug levels:
• None (default)
• Debug: Additional information is provided in the Logs view.
• Detailed: Graphical indications, applied to the objects in the

scene, that allow you to visualize interactions and forces
applied to those objects, allowing further investigation of the
physics of the simulation.

Camera Section
Command Shortcut Description

Reset F5 Resets the camera to the default mode.

Orthogonal F12 for the
Top view

Displays the Model view without perspective. This allows you to
visualize the scene from different angles and to align your
components accurately.

The following Orthogonal views are available:
• Top
• Front
• Left
• Back
• Right

To return to the default view with perspective, move the camera or
click the View > Reset button.

Fit - Displays all components in the Model view simultaneously.

Camera
[1...9]

Ctrl + Shift +
[1...9]

Allows you to save up to 9 different camera positions by pressing
Ctrl + Shift + a number between 1 and 9.

To go to one of the saved positions, click the Camera button with
the corresponding number or the shortcut Ctrl + the
corresponding number.
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Command Shortcut Description

Clear - Resets the saved camera positions.

Export - Allows you to export the camera positions to an XML file.

Import - Allows you to import a camera position from an XML file.

Follow Load - Follows a selected load on the way through the scene.

Shadow Section
Command Shortcut Description

Shadow - Move the slider from Off to Solid to determine how much of a
shadow the production line casts.

Lighting - Select from the list where the light source is placed in the scene.

The following places are available:
• Top
• Front
• Back
• Left
◦ Perpendicular
◦ Front
◦ Back

• Right
◦ Perpendicular
◦ Front
◦ Back

Visibility Section

Command Shortcut Description

Motors Ctrl + M Click this toggle button to switch the visibility of motors on and
off.

Label Ctrl + E Click this toggle button to switch the visibility of labels on and
off. Labels are displayed as tooltips when hovering over an
assembly in the Model view.

Settings Menu

Commands of the Settings Menu
Click the Settings button to open the view for configuring the settings for the
different functions and features. It is grouped in different sections:
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Camera Section
The Camera area allows you to configure shortcut keyboard keys for moving the
cameras.

By default, the Use Standard Configuration check box is not selected. To define
your own shortcuts, enter the key you want to use per camera movement in the
different lines.

To use the following default keys, select the Use Standard Configuration check
box:

Camera movement Default keyboard key

Forward W

Backward S

Pan Left A

Pan Right D

Rotate Left Left Arrow

Rotate Right Right Arrow

Zoom In Up Arrow

Zoom Out Down Arrow

Snapping Section
The Snapping area allows you to enter the radius (in meters) in which the
assembly snaps to the nearest assembly automatically while double-clicking the
assembly and holding down the Ctrl key.

Globalization Section
The Globalization area allows you to select the Measurement System: Metric or
Imperial.

Pointer Section
Check box Setting

Keep the selection when placing
a new assembly

If the check box is not selected, the new assembly continues
to follow the arrow pointer when you move it around the
scene.

If the check box is selected, the new assembly is placed at
the position that you click first.

To be able to move and rotate
you have to hold down the left
mouse button when this feature
is enabled.

Select this check box to help avoid moving the assembly
unless you hold down the left mouse button while turning it.

Invert rotation Change the way you move across the screen with the
mouse.
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Copy/Paste Section

Function / Feature Setting

Mode Select where to insert an assembly you copied:
• Mouse: The copied assembly is inserted at the position

of the mouse.
• Offset: The copied assembly is inserted next to the

source object.

Snap Select this check box to snap a copied assembly to the
nearest assembly. As a prerequisite, the assembly must be
equipped with snapping points.

Continuously Copying Select this check box to place assemblies continuously with
an offset related to the last assembly you pasted.

Statistics Section
Function / Feature Setting

Random Seed Click the up or down buttons to set the number you wish to
use to initialize a pseudo-random sequence.

Warn on determinism lost Select this check box to display advisory messages when the
random sequence differs form the previous random
sequence.

Visibility Section

Check box Setting

See assemblies being
constructed

Select this check box to see how the scene builds up when
you load it instead of displaying all components at once.

Display warning signs in locked
mode

Select this check box to display advisory messages when the
scene is locked.

Tools Menu

Commands of the Tools Menu
The Tools Menu is grouped in different sections:

Capture Section

Command Description

Screen Shot Takes a screen capture of the Model view that you can save to a folder of your
choice in .png or .jpg format.

Assembly Shot Takes a screen capture of the assemblies you selected in the Model view. You
can save it to a folder of your choice in .png or .jpg format.
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Measure Section
Click the Measure button and then click within the Model view to display a
measuring tape. It is a good practice to switch to top view for displaying the
measuring tape.

To measure the distance between different components, hold down the Ctrl key to
snap the tape to snap points. An alternative method, which is not as accurate, is to
drag the arrows of the tape.

Model Menu

Commands of the Model Menu
The Model menu is grouped in different sections:

Time Section
Command Shortcut Description

Play - Starts the physical simulation.

Scale - Click to open the list of available execution speeds for the scene
and select a speed rate.

NOTE: Selecting an execution speed higher than 1 can lead
to inaccuracies.

The option 1x sets the execution speed to real time which is
indicated by 1 displayed in the status bar below the Model view.
Alternatively, click the button 1:1 for real time setting.

Increase - Click to increase the execution speed by 0.1.

Decrease - Click to decrease the execution speed by 0.1.

Infinity - Click to set the execution speed to 10.
NOTE: Selecting an execution speed higher than 1 can lead
to inaccuracies.

1:1 - Click to set the execution speed to real time.

Reset Ctrl + R Click to reset time and machines to 0 and to delete the loads.
NOTE: To reset the recording of events, click the Reset
button.

Single Step - Switch the Single Step function On by sliding the control to the
right to pause after every time step.

Event Recorder Section
The commands provided in this area allow you to record events that occur during
connection to a controller and save this recording to a separate *.events file. This
file can be replayed to allow for reviewing the behavior of the scene or to perform
repetitive tests with a fixed timing without a controller being connected.
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Command Shortcut Description

Record /
Stop

Replay

- Connect to a controller and click to start / stop the recording of
events being displayed in the Model view. Events include, for
example, incoming TCP/IP messages, signals from a controller
(controller outputs), manual feeding of loads.

After you have loaded a *.events file, click the Replay button to
start replaying the recording.

While replaying an events file, further information on the events is
provided in the status bar at the bottom of the Model view.

Load - Click to load event recordings.

As a prerequisite for replaying a recording, do the following:
• Disconnect from the controller from which you recorded the

events.
• Click the Reset button from the Time area to reset the

scene.

Save - Click to save event recordings in *.events format.

Options - Click to open the options for event recordings:
• Pause when buffer is empty
• Display the time for next recorded event

Statistics Section
Command Shortcut Description

Snapshot - Click to open a Save As dialog box allowing you to export the
information about the scene and to save them as . csv file.

Info - Opens a Model Information window that provides information
about the number of Assemblies, Motors, Parts, Connections,
Outputs, Inputs, PhysX available in the scene you are playing.

Selectables Section
Command Shortcut Description

Filter - Click to open the list of components of the scene that can be
displayed / hidden: Loads, Assemblies, Motors, Nodes.

Loads Section
Command Shortcut Description

Move - Click to prevent loads from being moved.

Eat - Click to automatically delete loads that have fallen to the floor.

Routes Section
Command Shortcut Description

Auto / Man - Click to select whether you want EcoStruxure Machine Expert
Twin to calculate routes on the assembly line if more than one
option is available, or if you want to do it manually.
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Kinematization Menu

Commands of the Kinematization Menu
The Kinematization menu is grouped in different sections:

• Create Section, page 31
• Assembly Section, page 37
• URDF Section, page 37

It allows you to create body assemblies and kinematic axes as well as to import
CAD files and to create customized kinematics with these elements.

Create Section
The Create section allows you to create body assemblies of the selected type
within the scene at the default position. When a body assembly is selected, its
local coordinate system is displayed in the scene and its properties are displayed
in the Properties view, page 32.

Command Description

Box Click to add a box to the scene at the default position (X=0, Y=0, Z=500 mm).

Cylinder Click to add a cylinder to the scene at the default position (X=0, Y=0, Z=500
mm).

Sphere Click to add a sphere to the scene at the default position (X=0, Y=0, Z=500
mm).

CAD/Convex Click to import a *.dae or *.stl file and to add the CAD drawing together with the
convex mesh at the default position to the scene.

NOTE: In case your CAD file does not contain information on units (such
as millimeter or inch), EcoStruxure Machine Expert Twin by default
interprets the dimensions of objects as meter. To achieve a correct
interpretation of dimensions, rescaling in your CAD tool may be required
before importing the file into EcoStruxure Machine Expert Twin.

For further information, refer to Importing a CAD File, page 34.

Kinematic Axis Click to add a kinematic axis at the default position to the scene.

Alternatively, select one or multiple body assemblies before clicking the
Kinematic Axis button. One kinematic axis is then created as parent node per
selected body assembly.

A kinematic axis allows you to move the associated body assembly or imported
CAD object within the scene. The motion can be controlled by controller signals
or a motor can be added as sub device to the kinematic axis to generate
motion.

For further information, refer to Properties of a Kinematic Axis, page 34.
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Properties of Body Assemblies
To customize a body assembly you have added to your scene using the
Kinematization menu, select it in the Model view and configure your settings in
the Properties view.

With the Dynamics > Parameters, configure the following:

Parameter Description

Type Select from the list:
• Bodiless: The body assembly is displayed only for visualization

purposes. No interaction with other objects in the scene or with the
physics is performed.

• Rigid: The body assembly interacts with other objects in the scene but
is not subjected to gravitational forces.

• Physics: The body assembly interacts with other objects in the scene
and is subjected to gravitational forces.

Min Position
Iterations

Enter the minimum number of iterations executed by the physical simulation
to calculate the position of the body assembly based on the forces acting on
it.

Default value: 4

Min Velocity
Iterations

Enter the minimum number of iterations executed by the physical simulation
to calculate the velocity of the body assembly based on the forces acting on
it.

Default value: 1

Center Of Mass By default, the center of mass is in the center of the body assembly with the
setting: 0:0:0 mm.

To shift the center of mass, edit the X, Y, and / or Z coordinate of the local
coordinate system.

Weight Enter the weight of your body assembly (in kg).

Default value: 1 kg

Collision The property is available if the parameter Type is set to Rigid or Physics.

It allows you to enable or disable collision detection with body assemblies in
the scene without impact on the collider. It is mainly used for Physics
Joints.

Gravity The property is available if the parameter Type is set to Physics.

It allows you to enable or disable the effect of gravity on the selected body
assembly. It is mainly used for Physics Joints.

With the Geometry > Parameters, configure the following:

Parameter Description

Type Select the type of your body assembly and configure the corresponding sub
parameters. You can change the type whenever required.

• Box
◦ Length
◦ Height
◦ Width

• Cylinder
◦ Length
◦ Radius

• Sphere
◦ Radius

• CAD/Convex
◦ Scale: Enter the scale factor to resize a CAD drawing with respect

to the original size. The default value is 1 (no scaling).

Local Position Edit the X, Y, and / or Z coordinate to modify the position of the body
assembly with reference to the origin of its own assembly coordinate
system.

Default value: 0:0:0 mm
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Parameter Description

Local RotX Enter a rotation angle in ° to rotate the body assembly around the X axis of
its assembly coordinate system.

Default value: 0°

Local RotY Enter a rotation angle in ° to rotate the body assembly around the Y axis of
its assembly coordinate system.

Default value: 0°

Local RotZ Enter a rotation angle in ° to rotate the body assembly around the Z axis of
its assembly coordinate system.

Default value: 0°

Visible Deselect the check box to hide the body assembly from the scene. With the
check box deselected, the body assembly is not displayed. When it is
selected (for example, in the Properties view) its assembly coordinate
system is displayed along with the body assembly.

With the Global Pose parameters, configure the following:

Parameter Description

Position Edit the X, Y, and / or Z coordinate to modify the position of the body
assembly within the scene.

Default value: 0:0:0 mm

RotX Enter a rotation angle in ° to rotate the assembly and its local assembly
coordinate system around the X axis.

Default value: 0°

RotY Enter a rotation angle in ° to rotate the assembly and its local assembly
coordinate system around the Y axis.

Default value: 0°

RotZ Enter a rotation angle in ° to rotate the assembly and its local assembly
coordinate system around the Z axis.

Default value: 0°

Select the Position > Locked check box to lock the position of the body assembly
to help prevent it from being moved within the scene.

The Scripts > Event parameters allow you to configure programming code that is
executed when a selectable event is detected on the body assembly:

Parameter Description

Events Select one of the following Events:
• Deselect
• DoubleClick
• Reset
• Select

Click the Source > ... button of the event to open the Script
view, page 48.

The Visualization parameters allow you to configure programming code that is
executed when a selectable event is detected on the body assembly:

Parameter Description

Visible Deselect this check box to hide the body assembly in the
scene.

Color If the Visible check box is selected, select a color for the
body assembly.
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Importing a CAD File
EcoStruxure Machine Expert Twin supports the import of files with the file
extensions .dae (Collada file) and .stl.

NOTE: In case your CAD file does not contain information on units (such as
millimeter or inch), EcoStruxure Machine Expert Twin by default interprets the
dimensions of objects as meter. To achieve a correct interpretation of
dimensions, rescaling in your CAD tool may be required before importing the
file into EcoStruxure Machine Expert Twin.

To add a CAD drawing together with the convex mesh at the default position (X=0,
Y=0, Z=500 mm) to the scene, proceed as follows:

Step Action

1 Click the CAD/Convex button from the Kinematization menu.

Result: The Importing CAD File dialog box is displayed.

2 Browse to the CAD file and click Open.

Results:
• If you have selected an .stl file for import, the content of the file is displayed as new

assembly in the scene and one new node is added to the Assemblies tree of the
Solution Explorer.

• If you have selected a .dae file for import, the message Split the Collada File is
displayed requesting you to decide whether you want to import this Collada file as
one assembly to the scene (proceed with step 3a) or to split it into its sub
assemblies (proceed with step 3b).

3a To import this Collada file as one assembly to the scene, click No.

Result: The content of the file is displayed as new assembly in the scene and one new
node is added to the Assemblies tree of the Solution Explorer.

3b To split the Collada file into its sub elements and to import them as individual
assemblies, click Yes.

Result: The content of the file is displayed as new assembly in the scene and several
new nodes are added to the Assemblies tree of the Solution Explorer representing the
sub elements that exist in the Collada file.

To display the convex mesh in the scene, execute the command Level > Detailed
from the Debug section of the View menu, page 25.

Properties of a Kinematic Axis
To customize a kinematic axis you have added to your scene using the
Kinematization menu, select it in the Model view and configure your individual
settings in the Properties view.

The Coordinate Axes > Properties parameters allow you to configure the local
coordinate system of the kinematic axis:

Parameter Description

Scale Allows you to scale the axes of the assembly coordinate system of the
kinematic axis that is selected.

Default value: 1.5

Visible Deselect this check box to hide the local coordinate system of the selected
kinematic axis in the scene.
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The Global Pose parameters allow you to configure the kinematic axis with
reference to the global coordinate system of the scene:

Parameter Description

Position Edit the X, Y, and / or Z coordinate to modify the position of the kinematic
axis.

Default value: 0:0:0 mm

RotX Enter a rotation angle in ° to rotate the kinematic axis around the X axis of
the global coordinate system.

Default value: 0°

RotY Enter a rotation angle in ° to rotate the kinematic axis around the Y axis of
the global coordinate system.

Default value: 0°

RotZ Enter a rotation angle in ° to rotate the kinematic axis around the Z axis of
the global coordinate system.

Default value: 0°

From the Motion > Type list, select the following options:

Parameter Description

Fixed The kinematic axis is fixed and the associated body assemblies are not
moved.

This is the default setting.

Translation The kinematic axis exerts a translational movement on the associated body
assembly.

Rotation The kinematic axis exerts a rotational movement on the associated body
assembly.
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With Motion > Type selected, the following parameters are available:

Parameter Description

Axis Select the direction of movement based on the assembly coordinate system:
• X
• Y
• Z

NOTE: The assembly coordinate system can be rotated which can
have the effect that the directions differ from the global coordinate
system.

Drive Type The three options add a Motor as sub node to the Kinematic Axis node.

Select an option from the list to define the controller input that is valid for the
motor:

• Position: A position value for the motor (in Units) is provided by a
variable from the controller.

• Velocity: A velocity value for the motor (in Units) is provided by a
variable from the controller.

• Forward/Backward: Boolean forward/backward signals are provided
by a variable from the controller.

The motor is configured with the parameter Drive in this list of Motion
parameters.

Units Select the units of movement:
• For translational movement:
◦ Millimeters
◦ Meters

• For rotational movement:
◦ Degrees
◦ Radians

Limits To limit the movement, activate the option Use Limits and configure the
parameters (the units configured with the Units parameter are used):

• Min. Limit
• Max. Limit
• PLC Input - Min. Limit
• PLC Input - Max. Limit

Drive Configure the motor according to the selection for the parameter Drive
Type.

The motor parameters are configured as described in the How to Use
Device Catalogs User Guide. Alternatively, you can right-click the motor
node in the Solution Explorer and control the motor manually with the
Stop, Start, Forward, Backward commands

Select the Position > Locked check box to lock the position of the kinematic axis
to help prevent it from being moved within the scene.

The Scripts > Event parameters allow you to configure programming code that is
executed when a selectable event is detected on the kinematic axis:

Parameter Description

Events Select one of the following Events:
• Deselect
• DoubleClick
• Reset
• Select

Click the Source > ... button of the event to open the Script
view, page 48.

The Visualization parameters allow you to configure programming code that is
executed when a selectable event is detected on the kinematic axis:
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Parameter Description

Visible Deselect the check box to hide the kinematic axis in the
scene.

Color If the Visible check box is selected, select a color for the
kinematic axis.

Assembly Section

Command Description

Create Creates an empty container assembly. It allows you to group body assemblies
and to create parent-child relationships. Click the Create button.

A new node Assembly [n] is added to the Solution Explorer. When this node
is selected, the empty assembly is represented by a local coordinate system in
the scene.

Attach Creates parent-child relationships between assemblies or kinematic axes.

To achieve this, select a container or a body assembly or a kinematic axis in the
scene or in the Solution Explorer, hold down the Ctrl key and select another
body assembly or a kinematic axis. Click the Attach button.

As a result, the second assembly is displayed as a sub node of the first
assembly in the Solution Explorer view. In the scene, the two assemblies act
as one assembly. The relative relationship is fixed and is maintained while
moving them within the scene.

You can attach more body assemblies to the same parent assembly or you can
create another hierarchy level by selecting the child assembly in the scene or in
the Solution Explorer, holding down the Ctrl key and selecting another body
assembly.

Detach Removes a parent-child relationship between assemblies and kinematic axes.

To achieve this, select an assembly in the scene or in the Solution Explorer
that is a child of another assembly. Click the Detach button to untie this
relationship.

As a result, the former child assembly is now displayed as a node in the root
level of the Solution Explorer view. In the scene, there is no longer a fixed
relative relationship between the two assemblies.

URDF Section
Command Description

Import Click to import a URDF (Unified Robotics Description Format) file or
alternatively an XML (eXtensible Markup Language) file that contains the
adequate information. Browse to the file in the Importing URDF File dialog box
and click Open.

Result: The imported robot is displayed in the scene and a new node is created
in the Solution Explorer view with sub nodes representing the body
assemblies and kinematic axes the robot consists of.

EIO0000005022.01 37

Menu Bar Getting Started



Auto-Generation Menu

Commands of the Auto-Generation Menu
The Auto-Generation menu allows you to read the configuration of a multi carrier,
a robot or a servo belt and to create the corresponding assemblies after having
established a connection to the controller. As a prerequisite, the IP address and
the connection parameters must be configured correctly and an OPC UA
connection must be established. For further information on the prerequisites, refer
to:

• The Procedure for Starting the Emulation in the How to Emulate User Guide
of the EcoStruxure Machine Expert online help.

• The description of Creating Emulation Data in the Lexium™ MC multi carrier
Configuration Guide of the EcoStruxure Machine Expert online help.

The menu is grouped in different sections:

multi carrier Section
Command Description

Name Enter the name of the multi carrier object to be generated, for example, MC_
Track_1.

Connection ID Select the Connection ID from the list in accordance with the Connections
view, page 39.

Load Object Click to establish a connection to the configured controller and to read the
configuration of the multi carrier.

You can also click the button to update the created assemblies after you have
modified the configuration of the multi carrier.

Robots Section
Command Description

Name Enter the name of the robot object to be generated, for example, T_Robot_1.

Connection ID Select the Connection ID from the list in accordance with the Connections
view, page 39.

Load Object Click to establish a connection to the configured controller and to read the
configuration of the robot.

You can also click the button to update the created assemblies after you have
modified the configuration of the robot.

Servo Belts Section
Command Description

Name Enter the name of the servo belt object to be generated, for example, Infeed_
Belt.

Connection ID Select the Connection ID from the list in accordance with the Connections
view, page 39.

Load Object Click to establish a connection to the configured controller and to read the
configuration of the servo belt.

You can also click the button to update the created assemblies after you have
modified the configuration of the servo belt.
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Connections View
What’s in This Chapter

Connections View........................................................................................39

Connections View

Creating Connections
The Connections view allows you to create connections to your controllers or
higher level systems. By default, the view is empty. Right-click within the view to
open the Communication dialog box for selecting the communication protocol for
your connection.

Select a communication protocol and an entry will be displayed in the
Connections view for this connection.

By default, the following communication protocols are supported:

Address-based communication protocols:
• Siemens
• Modbus TCP
• Serial (Raw)
• XCom

Tag-based communication protocols:
• Beckhoff ADS
• OPC UA Client

Messages-based communication protocols:
• STC/ETX
• 3964R
• RFC 1006
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Configuring Connections
For a detailed description on how to configure an OPC UA connection, refer to the
EcoStruxure Machine Expert Twin How to Use Device Catalogs User Guide.

In general, configure a connection in two steps:
1. Select the row in the list of the Connections view and configure the

corresponding settings in the Properties view.
2. Right-click the row in the list of the Connections view to open the contextual

menu providing the following commands, depending on the connection type:

Command Description

Connect All / Disconnect
All

Connects / disconnects all controllers simultaneously providing you
have entered an IP address for each connection.

Connect / Disconnect Connects to / disconnects from the selected controller.

Generate SmartVisu

Only available when an
OPC UA connection to a
PacDrive LMC or a
Modicon M262 Motion
Controller
(TM262M25MESS8T,
TM262M35MESS8T) is
established.

Reads the settings made in the DigitalTwinCommunication library and
displays a 3-D digital twin of your machine in the Model view.

The connection from EcoStruxure Machine Expert Twin to the
controller is using a handshake mechanism to acknowledge that
event data was received and ensure consistent information is
displayed in the Model view (single-instance mode).

In the case of multiple connections from EcoStruxure Machine Expert
Twin to the same controller, the primary connection is verifying the
data exchange by the handshake mechanism. Further connections
are working in multi-instance mode, and can process event data
simultaneously, but the handshake mechanism is not used for multiple
connections.

In few cases, under high utilization of the communication bandwidth,
full transmission of events may not be possible, and might result in
events not being displayed in the instances using multi-instance
mode.

For further information, refer to the EcoStruxure Machine Expert
DigitalTwinCommunication Library Guide.

Remove SmartVisu

Only available when an
OPC UA connection to a
PacDrive LMC or a
Modicon M262 Motion
Controller
(TM262M25MESS8T,
TM262M35MESS8T) is
established.

Removes all assemblies and loads generated from this connection
from the Model view.

For further information, refer to the EcoStruxure Machine Expert
DigitalTwinCommunication Library Guide.

Listen / Disconnect Listens to / disconnects from the selected server.

The communication protocols RFC 1006 and 3964R TCP/IP can act
as server or client depending on the configuration in the Properties
view.

Enable Logging Logs the messages sent by the controller and displays them in the
Logs view, page 49.

Truncate Log If logging is enabled on the controller, text files (*.txt) are created in
your local Windows user directory:

%localappdata%\Schneider Electric\Machine Expert Twin\1\Work
\Logs

The log files are updated when the project is closed.

With this option selected, the log files are cleared when the project is
opened.

Import Imports the addresses from an Excel file to the controller.

Export Exports the addresses from the controller to an Excel file.

Alarms Opens the Alarm Scheme dialog box that allows you to set alarms
and which error messages they will display. For further information,
refer to the description of the Alarm Scheme Dialog Box, page 41.

Delete Deletes the connection.
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Alarm Scheme Dialog Box
In the Connections section, right-click on a connection and select Alarms to
display the Alarms Scheme dialog box.

Column Description

Subscribe Select whether or not the alarm is activated.

• Address
• Bit
• Source

These parameters define the address of the alarm.

Description Enter the description for the alarm.

If the data exchange to the controller is address-based, add alarms when the
controller is not connected. If the data exchange is tag-based, add alarms when
the controller is connected. Also refer to the description of the Alarms view, page
53.
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Catalogs View
What’s in This Chapter
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Catalogs View

General Information
The Catalogs view displays the catalogs that have been selected during start-up
of EcoStruxure Machine Expert Twin in the Select Catalog(s) dialog box.

Catalogs are handled as DLL files that are by default provided in the EcoStruxure
Machine Expert Twin installation folder. The default catalogs are extended by the
prefix Experior.Catalog, for example Experior.Catalog.SchneiderElectric.
Accessories.dll.

Catalogs function as a form of libraries that provide different assemblies and other
items. You can also create your own catalogs using the C# programming
language. To reference your own catalogs, click the browse (...) button in this
dialog box and browse to the folder that contains your catalogs.

Selecting Objects from Catalogs
The Catalogs view displays the catalogs you selected in the Select Catalog(s)
dialog box either in a Gallery View Style or in a Tree View Style. Select a catalog
to see the objects it contains. To use an object in your scene, select the object,
position the cursor in the Model view and click to place the object.

If the Gallery View Style is selected, objects you insert consecutively are
automatically connected. For example, you can insert different types of conveyors
consecutively by double-clicking the conveyor objects in the Belts & Conveyors
catalog. As a result, each new conveyor is snapped to the end of the last conveyor
extending the line of conveyors.

For further information, refer to the EcoStruxure Machine Expert Twin How to Use
Device Catalogs User Guide.
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Control Panel View
What’s in This Chapter

Control Panel View ......................................................................................43

Control Panel View

Creating Controls
The Control Panel view allows you to insert controls for communicating with the
controller. Right-click on an empty square of the Control Panel view to open a
contextual menu that provides different types of controls:

The Buttons work when you press them while the Lamps light up when a specific
controller signal is sent.

The Knob allows you to switch between different values which you can select in
the Properties view.

The Gauge displays values sent from the controller.

The Switches option allows you to choose between two-state and three-state
switches.

After you have selected a control, you can edit the properties in the Properties
view such as name and color.
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Copying / Pasting / Removing Controls
To copy a control, right-click it in the Controls (n) tab and execute the command
Copy from the contextual menu.

Right-click in the Controls (n) tab and execute the command Paste to insert the
control you copied.

To remove a control, right-click it in the Controls (n) tab and execute the
command Delete from the contextual menu.

Managing Control Panel Tabs
To manage the tabs of the Control Panel view, right-click the header of a
Controls (n) tab. A contextual menu with the following commands is displayed:

Command Description

Left / Right

First / Last

Allows you to move a Controls (n) tab to the left, to the right, to the first or to
the last position.

New Control Panel Creates a new Controls (n+1) tab and inserts it at the right end.

Duplicate (tab
name)

Copies the active tab with its content and inserts it as new tab with tab name
Copy of (tab name) to the right of the existing tabs.

Delete (tab name) Deletes the active tab.

Delete All Deletes all tabs. As a result, the two empty default tabs Controls (1) and
Controls (2) are provided.

Undock Allows you to move the selected tab to another position in the EcoStruxure
Machine Expert Twin screen.

Alignment Allows you to display the tab headings not at the Top of the Control Panel
view, as it is by default, but at the Bottom, the Left or the Right of the view.
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Model View
What’s in This Chapter
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Model View

Overview
The Model view is where you display your scene and its constituent assemblies
and loads. You can also graphically visualize what happens when you play the
scene.

The three arrows in the middle represent the 3-D coordinate system of the Model
view using the colors X = red, Y = green, Z = blue. For further information, refer to
Information About the Coordinate System, page 17.

Zooming, Rotating, Moving the Camera View
To zoom the camera view within the Model view, scroll the mouse wheel or set the
zoom shortcuts in the Settings menu, page 26.

To rotate the camera view, hold down the left mouse button, and move the mouse.

To move the camera view, hold down the right mouse button, and move the
mouse.

Rotating Objects in the Scene
Select an object in the Model view and perform the following mouse actions for
rotation around the different axes:

Mouse Action Rotation around axis

Scroll the mouse wheel Z

Hold down the Ctrl key and scroll the mouse wheel Y

Hold down the Alt key and scroll the mouse wheel X

Sections
By default, the Model view contains one section. The section is the container of
assemblies inside a scene. The default section has a size of 50,000 mm x 50,000
mm and can be modified in the Properties view. The floor of the section is
displayed gray by default but if you flip the scene to see it from below the floor
appears transparent. In the Properties view, the floor can be modified regarding
color and type.
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Adding Sections
To add sections to the Model view, proceed as follows:

Step Action

1 In the Solution Explorer view, right-click the Assemblies node and execute the
command Add Section from the contextual menu.

Results:
• In the Solution Explorer view, a new node Section[n+1] is added below the last

section node.
• In the Model view, a new section is displayed on top of the existing section. Unless

you changed the dimensions or the position of the existing section you will not be
able to see the new section immediately as it is directly on top of the existing.

2 In the Solution Explorer view, select the node of the new section, to make it active.

Result: Further information on the section is displayed in the Properties view.

Modifying the Floor Using the Section Properties
You can modify what is displayed as the floor in the Model view by modifying the
properties of the section. Proceed as follows:

Step Action

1 In the Solution Explorer view, expand the Assemblies node and select the Section
node.

2 In the Properties view, modify the properties.

• With the parameter Section > Name you can assign a name to the section
that is displayed at the lower right corner of the floor in the Model view.

• To hide the selected section from the Model view, deselect the check box
Visible.

• Enter the Size > Width and Size > Length of your choice to modify the size
of the section.

• Enter the Transformation > Position > 0:0:0 mm and / or the
Transformation > Yaw (in °) to modify the position of the section in space (in
a cartesian coordinate system).

• Select an option from Assemblies to move, lock, enable or select assemblies
in the selected section.

• Select another option from Floor > Type to modify, for example, the color or
the texture of the section displayed as floor.

• In Grid, you can, for example, hide the grid and enable bounds or you can
import a floor design of your choice by selecting the option AutoCAD and
importing a *.dxf or *.dwg file.

The properties defined here are specific to the selected section. When you open a
new Model view, a default section with the default settings opens.
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Status Bar
The status bar at the bottom of the Model view displays information about the
scene:

Column Description

Paused / Running Indicates if the time is running (the scene is playing) or paused.

Scan Indicates the time (in ms) it took to calculate the last step of the physical
simulation. If this number becomes too high, an advisory message will be
displayed on the right-hand side of this status bar.

Lock icon Indicates whether the scene is locked.

Time displayed as
[dd:hh:mm:ss]

Displays the time elapsed while playing the scene.

Time scale Displays the time scale for playing the scene, such as:

1 = real time

2 = double real time

The maximum is 10 times real time.

Information and
diagnostic
messages

Provides information and advisory messages that are relevant while playing
the scene. The messages are color-coded according to the severity. For
information on messages provided in the Logs view, refer to the chapter
Logs View, page 49.
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Script View
What’s in This Chapter
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Script View

Overview
The Script view allows you to write scripts inside EcoStruxure Machine Expert
Twin using the C# programming language.

To integrate the code in the program, click the Build button on the left side of the
button bar or execute the Build project command from the Build menu.

Errors that are detected during the build process are displayed in the Error List
view below the Script view.
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Logs View
What’s in This Chapter
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Logs View

Overview
The Logs view provides information on how the program is running and displays
different types of messages. By default, time stamps are added and the messages
are color-coded according to their severity. You can disable the time stamp and
the color in the Properties View, page 62.

NOTE: It is also possible to disable log messages completely. Thus, if the
Logs view is empty, verify whether the Mode parameter in the Properties of
the Logs view is set to None.

Message type Description Color

Action Notification concerning a certain action executed
in the scene.

black

Communication Notification providing controller information,
such as connection set.

black

Error An error has been detected. red

System Information provided during start-up of
EcoStruxure Machine Expert Twin.

blue

Debug Customized messages defined in the Script
view, page 48 with the command ‘Log.
DebugMessage<”Your message”>’ to be
generated, for example, when activating a
specific object.

black

Warning Advisory messages indicating that the scene is
not playing properly, for example, due to the
connection to the controller being interrupted.

orange

Information General information about the instance. green

Select the check box Tail to activate an automatic scrolling function to display new
log messages that are added at the end of the Logs list. If this check box is not
selected, you will have to scroll manually to the latest log messages at the end of
the list.

Contextual Menu
Right-click a message to open a contextual menu with the following commands:

Command Description

Clear Deletes all messages from the Logs view.

Copy Copies the selected line or lines to the clipboard.

Insert Separator Inserts a line with the time stamp at the end of the messages. This can be
useful to structure the log, for example, to mark the time when a test is being
started.
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Customizing the Logs View
To customize the log messages, select a message and configure your individual
settings in the Properties view, page 62.
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Loads View
What’s in This Chapter
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Loads View

Overview
The Loads view displays the loads that are available in the scene. This
information is relevant for discrete events mode.

Selecting a load in the Loads view also selects the load in the Model view.
Further information on the selected load is displayed in the Properties view, page
63.

Information Provided in the Loads View
To fill or update the columns of the Loads view, right-click within the Loads view
and execute the command Refresh. The following information is displayed:

Column Description

Identification Displays the identifier (usually a barcode) of each load.

To modify the identifier of the load, edit the Identification parameter in the
Properties view, page 63.

Next Indicates the next action point the load will hit.

Destination Indicates the final destination of the load.

Description Provides further information on the load.

Further Information in the Properties View
For further information on the selected load and modification of the Identification
parameter as well as the color, refer to the Properties view, page 63.
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Inputs / Outputs Views
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Inputs / Outputs Views

Overview
Inputs and outputs (I/Os) are relevant for connections to controllers.

The Inputs view displays the inputs the controller receives, such as sensor
signals.

The Outputs view displays the outputs that are sent by the controller, such as
control commands.

Selected inputs / outputs are displayed in green.

Red cells within the table indicate that the parameter has not been configured
correctly.

Contextual Menu
Right-click in the Inputs / Outputs table to open a contextual menu with the
following commands:

Command Description

Add Adds a new input or output for the controller and adds a new row to this
table. You can also add new inputs or outputs through components.

Refresh Updates the content of the Inputs / Outputs table.

Export Exports inputs or outputs to an Excel file.

Further Information in the Properties View
The Properties view allows you to modify the symbol and the description of the
input / output.
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Alarms View
What’s in This Chapter
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Alarms View

Overview
The Alarms view displays the alarms you have created for performing controller
tests. To create an alarm, right-click a connection in the Connections view and
execute the Alarms command from the contextual menu to open the Alarm
Scheme dialog box, page 41.

Information Provided in the Alarms View
The Alarms view provides the following information:

Column Description

Connection Indicates the controller to which the alarm belongs.

Alarm Indicates the description that you have set for the alarm.

When an alarm is raised, it is displayed in the Alarms view, but will also be
displayed as an advisory in the status bar of the Model view, page 47.
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Joint Editor
What’s in This Chapter

Joint Editor View..........................................................................................54

Joint Editor View

Overview
The Joint Editor view allows you to create Physics Joints between two or more
body assemblies created with the Kinematization Menu, page 31.

The Physics Joint is configurable in the editor and allows you to lock or allow the
six degrees of freedom (DOF) individually.

For a joint, one reference is considered the stationary reference (rigid), while the
other is considered the moving reference (physics). The moving and the stationary
references of the joint must be located on two different body assemblies.

Example of a Physics Joint configuration in the Joint Editor:

The editor automatically verifies the configuration and indicates detected
configuration issues by a red triangle in each box that is affected. A tooltip is
provided that indicates a solution. The total number of issues detected in the
editor is displayed in the lower left corner.

The Joint Editor provides two buttons in the upper right corner:

Button Description

Moves the camera to
position 0.0.

Click to move the camera view of the editor to the upper left edge.

Fits all nodes within the
view

Click to zoom in or out of the editor view so that all available objects
are displayed.
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Creating Physical Joints
To create a physical joint between two assemblies, proceed as follows:

Step Action

1 Right-click in the Joint Editor view and execute the command Add Body from the
contextual menu.

Result: A new body block is displayed in the Joint Editor.

2 Create a relationship between the block in the Joint Editor and an assembly in the
scene by selecting the assembly in the scene or in the Solution Explorer, right-clicking
the block in the Joint Editor and executing the command Link to assembly from the
contextual menu.

Result: The name of the assembly is assigned to the selected block in the Joint Editor.

3 Repeat steps 1 and 2 to create a second block in the Joint Editor and to link it to a
second assembly in the scene.

Result: Two blocks representing two different assemblies are available in the Joint
Editor.

4 Right-click in the Joint Editor view and execute the command Add Physics Joint from
the contextual menu.

Result: A Physics Joint block is added to the Joint Editor.

5 Click in the frame of the first assembly, hold down the left mouse button and draw a
connecting line to the Origin connection point of the Physics Joint block.

Result: The first assembly is defined as origin or stationary reference for the joint and
the Origin connection point is highlighted in blue.

6 Verify the configuration of the body assembly that is connected as Origin:

The Dynamics parameter Type must be set to Rigid or Physics (refer to the Properties
of Body Assemblies, page 32). If the Type = Bodiless is selected, correct the
configuration.

7 Click the Child connection point of the Physics Joint block, hold down the left mouse
button and draw a connecting line to the second assembly.

Result: The second assembly is defined as child or moving reference for the joint, the
Child connection point is highlighted in blue.

8 Verify the configuration of the body assembly that is connected as Child:

The Dynamics parameter Type must be set to Physics (refer to the Properties of Body
Assemblies, page 32).

If this is not the case, a red triangle is displayed at the upper right corner of the body
block. To adapt the configuration, right-click the assembly that is defined as child and
execute the command Set to Physics from the contextual menu.

Result: The Dynamics parameter Type is set to Physics and the red triangle is
removed.

9 Configure the Physics Joint. For further information, refer to Configuring Physical
Joints, page 56.
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Configuring Physical Joints
By default, the six parameters representing the six degrees of freedom are set to
Locked:

• Linear X
• Linear Y
• Linear Z
• Rotation X
• Rotation Y
• Rotation Z

To allow motion in one or more directions, select Free from the list for the
respective parameters.

NOTE: In the Properties of the Child assembly, set the Dynamics
Parameters to Type = Physics for allowing the physical simulation to display
the motion in the scene.

To hide the Physics Joint from view, deselect the check box Visible. You can
then display it by executing the command Level > Detailed from the Debug
section of the View menu, page 25.

By combining the physical joints feature with the functions provided in the
Kinematization menu, you can create customized robot kinematics.
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Change History View
What’s in This Chapter
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Change History View

Overview
The Change History view records modifications performed in the Model view
such as adding an object.

You can right-click an entry in the list and execute the command Set the
assembly [ASSEMBLY NAME]’s properties back to what they were before
this action from the contextual menu to undo this specific action.
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Solution Explorer View
What’s in This Chapter
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Solution Explorer View

Overview
The Solution Explorer view lists the components you are using in the Model in a
tree structure consisting of categories:

• Assemblies
• Motors
• Controllers

By default, the items that are available under the Assemblies node are grouped
by section, as first subnode and then by the type of assembly as second subnode
(for example, Lexium P Robot). To avoid the categorization according to the type
of assembly, click the button Do not categorize the assemblies in the upper part
of the Solution Explorer view, on the left-hand side of the Search field.
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Category Assemblies
The category Assemblies provides the Sections available in the Model as
subnodes. Assemblies selected in the Solution Explorer view are highlighted in
the Model view. You can drag assemblies between different Section subnodes.
As an alternative, you can select the assembly you want to move and then change
the section it is placed under in the Properties view. By editing the Name
parameter in the Properties view, you can rename sections.

Right-clicking the Assemblies node opens a contextual menu with the following
commands:

Command Description

Add Section Adds a node Section[n+1] below the last section node.

Show All Sections Displays all sections that have been hidden previously.

Collapse All Closes all subnodes that are open.

Right-clicking a Section subnode opens a contextual menu with the following
commands:

Command Description

Hide All Sections But
This

Displays in the Model view only the assemblies that are placed in the
selected section.

Show All Sections After executing the command Hide All Sections But This this
command restores the assemblies of all sections in the Model view.

Hide Assemblies Hides the assemblies and the floor of the selected section from the
Model view.

Lock Assemblies /
Unlock Assemblies

Locks the assemblies that are available in the selected section. New
assemblies that you are adding are not locked.

Fit Resizes the floor to fit around the assemblies placed in the Model
view.

Delete Section[n] Deletes the selected section. It is not possible to delete the last
remaining section.

Disable Assemblies Disables the assemblies that are available in the selected section. To
indicate this, they are displayed gray in the Model view. If you attempt
to place a load on a disabled assembly, the load will “fall through” the
assembly. To re-enable disabled assemblies, execute the Disable
Assemblies command again.

Collapse All Closes all subnodes that are open.

Right-clicking the subnode of an assembly allows you to disable or delete this
assembly.

Category Motors
Right-clicking a motor subnode opens a contextual menu with the following
commands:

Command Description

Start / Stop Starts / stops the motor.

Backward / Forward Toggles the moving direction of the motor.

Copy Copies the motor.

Disable Disables the motor.

Delete Deletes the motor.
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Category Controllers
Right-clicking the Controllers node opens a contextual menu providing the Load
command. It opens a File Open dialog box that allows you to browse for the
controller file.

Your file contains script code created or modified by you or by someone else. The
execution of the script code may compromise the security of your IT system.

WARNING
INFORMATION SYSTEM VULNERABILITY
• Ensure the integrity of the script code contained in the file by ascertaining

the originator and intent of the script before opening the file.
• Do not open the file if you can not determine the originator and intent of the

script, including confirming any modifications that may have been made.
• Verify and confirm that you want to execute this code when using the model

contained in the file.
Failure to follow these instructions can result in death, serious injury, or
equipment damage.

When attempting to open a file with a model containing script code, you are asked
to acknowledge this advisory and accept responsibility for the execution of the
code of the embedded script.

After the controller has been loaded, it will be displayed as a new subnode of the
Controllers node.
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Statistics View
What’s in This Chapter
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Statistics View

Overview
The Statistics view provides information about the loads in the scene monitored
by sensors.

You can monitor different types of sensors, such as scanners, weights, counters
and eaters. Scanners, for example, provide information about how many loads
they have scanned. The information for buttons indicates how many times they
have been pressed.

Managing Sensors
To add a sensor to the Statistics view, right-click it in the Model view and select
the option Observe in the contextual menu.

To modify the name of a sensor, proceed as follows:

Step Action

1 Select the sensor in the Model view.

2 Edit the Name parameter in the Properties view.

Result: The name is changed in the Model view.

3 To display the new name also in the Statistics view, right-click the sensor in the Model
view and deselect the option Observe in the contextual menu and then select the option
Observe again.
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Properties View
What’s in This Chapter
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Properties View

Overview
The Properties view provides information about items selected in different views
of EcoStruxure Machine Expert Twin, such as assemblies in the Model view,
buttons in the Control Panel or Connections. Parameters of the Properties view
that can be edited are displayed in black. Fixed values that cannot be edited are
displayed in gray.

The buttons in the upper left part of the view allow you to select whether to display
the properties as one list or grouped in categories.

Properties of the Logs View
To customize the log messages, select a message and configure your individual
settings in the Properties view:

Message parameters:

Parameter Description

Font Enter the font type and size for displaying the selected log message type.
For example:
[Font: Name=Courier New, Size=8.25, Units=3,
GdiCharSet=0, GdiVerticalFont=False]

Mode Select from the list whether to display the messages in Color or in Black.
For information on the types of messages and the corresponding color, refer
to the Logs View, page 49.

The option None switches off the log function. No new log messages will be
displayed.

Time/Clock

Log Format

Select the format of the time stamp from the Time/Clock list. The selected
format is indicated in the Log Format line.

• None: No time stamp is displayed for the log messages.
• Clock: The time stamp is displayed in

Log Format: [HH:mm:ss.fff]
• Elapsed: The time stamp is displayed in

Log Format: [{0:dd\.hh\:mm\:ss\.fff}]
• Simulated: The time stamp is displayed in

Log Format: [{0:dd\.hh\:mm\:ss\.fff}]
• DateTime: The time stamp is extended by the date and displayed in

Log Format: [yyyy-MM-dd HH:mm:ss.fff]
Elapsed and Simulated differ if the time scale (parameter Scale in the
Model menu, page 29) is set to value other than 1x as the Simulated time
would differ from elapsed time. The Simulated time is calculated from the
Elapsed time multiplied by the selected scaling factor.

Search Select the check box to highlight components that match a word in the
selected log message.
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File parameters:

If activated, log files are saved in the user directory of the logged in Windows user
in the following default path:

%localappdata%\Schneider Electric\Machine Expert Twin\1\Work\Logs

Parameter Description

Mode The following options are provided for log files:
• None: No log file is created.
• File: A log file is created in the default path with the default name

debug.log.
• FileDate: A log file is created with the file name derived from the

system date and time of day when EcoStruxure Machine Expert Twin
has been started.

• FileModelName: A log file is created when a project is opened or
saved with the project file name as log file name.

LogFile Wrap
Mode

This option is available if a log file is to be created. It defines how the log file
is buffered:

• Continuous: Append new log entries to an existing log file.
• Wrap: Append new log entries to an existing log file until the maximum

threshold is reached. Then the oldest entries are overwritten.
• Create new: Append new log entries to an existing log file until the

maximum threshold is reached. Then a new log file is created.

Filter parameters:

Parameter Description

Text Enter text you want to apply as a filter to the log messages. Only messages
that contain this text are displayed in the Logs view.

Type Select from the list the types of messages that are displayed in the Logs
view:

• None
• Action
• Communication
• Error
• System
• Debug
• Warning
• Information

For further information on the different message types, refer to the chapter
Logs View, page 49.

Highlight parameters:

Parameter Description

Text Enter a text string you want to highlight in the log messages.

Color Select the color to use for highlighting.

Properties of the Loads View
To customize a load, select it in the Model view and configure your individual
settings in the Properties view:

In Identification, the Type parameter indicates the type of the load, for example,
a box. With the Identification parameter, you can modify the identifier of the load
which is usually a barcode.

With the other parameters, you can define physical characteristics of the load, the
dimensions, the color and the position in space (in a cartesian coordinate system).
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Properties of the Inputs / Outputs View
The Properties view allows you to modify the symbol and the description of the
input or output.

Properties of the Alarms View
The Properties view provides further information on the alarm selected in the
Alarms view, page 53 for controller tests.

Properties of the Solution Explorer View
The Properties view allows you to modify the settings of the Assemblies, Motors
or Controllers selected in the Solution Explorer view. For further information on
the properties of catalog objects, refer to the EcoStruxure Machine Expert Twin
How to Use Device Catalogs User Guide.
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Getting Started

Glossary
D
digital twin:

A digital twin refers to a virtual representation or digital replica of a physical
object, system, or process. It is a digital counterpart that simulates the behavior,
characteristics, and performance of its physical counterpart in real-time or
historical contexts. The concept of a digital twin allows for the integration of the
physical and digital worlds, enabling organizations to monitor, analyze, and
optimize the performance of their assets or processes.

EcoStruxure Machine Expert Twin provides features for visualization, simulation,
and emulation of machines and automation lines throughout the complete
lifecycle.

E
emulation:

Based on the ISO 24765-2017 International Standard - Systems and software
engineering--Vocabulary, emulation is defined as the use of a data processing
system to imitate another data processing system, so that the imitating system
accepts the same data, executes the same programs, and achieves the same
results as the imitated system.

M
Model view: In EcoStruxure Machine Expert Twin, the Model view provides the
graphical representation of the scene.

P
physical simulation: The physical simulation is a software library that is designed
to simulate and model physical systems in a computer-generated environment. It
is used to create realistic and dynamic animations and simulations of objects,
environments, and interactions between them. In EcoStruxure Machine Expert
Twin the physical simulation uses mathematical algorithms to simulate physical
phenomena, such as gravity, friction, and collision detection.

project: An EcoStruxure Machine Expert Twin project file is saved with the
extension *.experior. It contains the information about assemblies, connections,
loads, settings.

S
scene: In the EcoStruxure Machine Expert Twin context, a scene is a
representation of a set of assemblies interacting with loads.

simulation:

Based on the ISO 24765-2017 International Standard - Systems and software
engineering--Vocabulary, simulation describes two concepts:

• A model that behaves or operates like a given system when provided a set of
controlled inputs.

• The use of a data processing system to represent selected behavioral
characteristics of a physical or abstract system.

In the context of this manual, the term simulation is used whenever it is referred to
modeling physical systems in EcoStruxure Machine Expert Twin.

EIO0000005022.01 65



Getting Started

U
URDF: (unified robotics description format) A special type of eXtensible Markup
Language (XML) file that includes the physical description of a robot and contains
information on the mechanical structure, joints, 3-D modelling graphics, motors
and colliders. URDF files are provided by numerous robotic manufacturers for
download. EcoStruxure Machine Expert Twin allows importing URDF files for
integrating third-party robots into a project without manual programming.
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renaming...........................................................58

EIO0000005022.01 67



Getting Started

section size...........................................................46
Select Catalog(s) dialog box .................................42
sensors ................................................................61
Settings menu......................................................26
size of the floor......................................................46
size of the section..................................................46
SmartVisu............................................................40
snapping function .......................................27–28, 42
Solution Explorer view.........................................58
starting a motor .....................................................59
Statistics view......................................................61

T
toolbar..................................................................20
Tools menu ..........................................................28
Tree View Style ....................................................42

U
undoing a specific change......................................57
URDF file import....................................................37

V
video sequences

merge functionality.............................................23
View menu ...........................................................24
views

reset .................................................................24

X
XML file import ......................................................22

Z
zooming the camera view.......................................45
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